Introduction

Welcome! This guide is intended to support you, the administrator, in deploying Corel® WordPerfect® Office X7 to your network.

Contents
Stage 1: Preparing for deployment ........................................... 2
Stage 2: Copying the contents of the DVD or extracting the ESD to the server .................................................. 6
Stage 3: Installing the software .................................................. 8
Stage 4: Maintaining the installations ....................................... 18
Appendix: Specialized deployment scenarios .......................... 25
Deploying Paradox ................................................................. 35

Conventions
Please note the following conventions used in this guide.

Wherever you see this You’ll find
italicized text A placeholder for user-specified information, such as a path or filename
bold monospace text A reference to programming syntax

For more information
The following resources offer additional support.

For information on See the following resource
deploying Corel® software: Corel® website:
concepts & processes, www.corel.com
general advice & best practices

Corel Corporation, or a specific Corel® Support Services website:
Corel software product www.corel.com/support

support for Corel software

the Microsoft® Windows® Installer (MSI) technology, which is used to install Corel software

Microsoft® website
Before beginning the deployment, take the time to familiarize yourself with your network and the software you want to deploy to it. Doing so can help your administrative duties run as smoothly as possible.

### In this stage
- Getting to know your network
- Getting to know the software
- Setting up your network accordingly

## Getting to know your network

Make sure to consider your network requirements for the deployment.

**Administrative factors**  Does your organization (or do you, as administrator) have any particular requirements for deploying and maintaining software?

**Server factors**  Does your server have any special characteristics or constraints?

**Workstation factors**  Do your workstations have any special characteristics or constraints?

**User factors**  Do your workstation users have any special workflows?

**For more information**  For general guidance on assessing your deployment needs, please refer to “Processes: Stage 1” in the Corel Beginner’s Guide to Network Deployment.

## Getting to know the software

Make sure that your server and workstations are eligible for the software. If your organization uses a document-management system (DMS), make sure that it is supported by the software.

**Server requirements**  You can copy or extract WordPerfect Office X7 to a server that meets the following requirements:

- Operating system with the latest service pack and critical updates:
- 1.5 GB of server space (for a typical installation without extra content)
Windows® Terminal Server (2012, 2012 R2, 2008, 2008 R1, 2008 R2, or 2003) is supported, but please note the following:

- You must use the WordPerfect Office X7 DVD or ESD to install the software on the server.
- Corel Corporation does not provide technical support for installing third-party software included with the product.

For details on server permissions, see “Server setup” on page 4.

**Workstation requirements**

You can install WordPerfect Office X7 on workstations that meet the following requirements:

- 32-bit or 64-bit version of Windows® 8.1, Windows 8, Windows® 7, or 32-bit version of Windows XP
- 466-MHz processor
- 256 MB of RAM
- 1.5 GB of hard-disk space for minimum installation (Paradox, if included, requires an additional 215 MB of hard-disk space.)
- Mouse or tablet
- 1024 × 768 monitor resolution
- Microsoft® Internet Explorer® 7.0 or later

Some features also require Microsoft® Outlook®.

For details on workstation permissions, see “Workstation setup” on page 4.

**DMS requirements**

WordPerfect Office X7 offers support for the WordPerfect® Office (WPD, WPT, WP, QPW) formats on the following document-management systems:

- Microsoft® SharePoint® Server 2013
- Microsoft SharePoint Server 2010
- Microsoft SharePoint Server 2007 with SP1
- SharePoint Portal Server 2003

For details on SharePoint setup, see page 4.

**For more information**

For important notes on installing and using the software, it’s a good idea to review the Readme file for the software.

**To access the Readme file on the installation disc**

- Run the following command line (where X: is the disc drive):

  `X:\ReadMe.htm`
Setting up your network accordingly

After familiarizing yourself with your network and the software you want to deploy to it, you can set up your network accordingly.

Server setup
Do the following:
• Make sure that you are either a local administrator or an administrator for the domains and workgroups that you are managing.
• Create a shared network location for the media you are copying or extracting to the server, and make sure that you have read/write access to that location.

If you want to make extra content (such as clipart and videos) available to workstation users, do the following:
• Set up a shared network location, and make sure that users have access to that location.
• Use the program DVD to install or copy the content to the shared location.

Workstation setup
Do the following:
• Make sure that you are — and anyone else who will be installing the software is — either a local administrator or an administrator for the domains and workgroups that you are managing.
• Make sure that you have — and anyone else who will be installing the software has — read access to the location where you copied or extracted media.

SharePoint setup
WordPerfect Office IFilter is installed automatically when you install WordPerfect Office X7. If you want WordPerfect Office IFilter as a standalone application, you can download it from here. To speed searches, install WordPerfect Office IFilter on all servers that will be hosting WordPerfect files. Detailed instructions on installing WordPerfect Office IFilter on Microsoft SharePoint 2013, Microsoft SharePoint 2010, and Microsoft SharePoint 2007 servers are available on officecommunity.com.

Step 1: Check your security settings
WordPerfect supports the SharePoint features for Windows Security. Be sure to configure the local domain to allow password authentication for your SharePoint server, which requires Hypertext Transfer Protocol over Secure Socket Layer (HTTPS/SSL) security.
Step 2: Install WordPerfect Office IFilter & SharePoint Resources

On your SharePoint server, run the appropriate WordPerfect Office IFilter executable file, which you can download from here. The setup installs the WordPerfect Office IFilter (for detecting and indexing stored WordPerfect documents), along with various other enhancements. Detailed installation instructions are available on officecommunity.com.

Step 3: Deploy SharePoint support

Workstations automatically receive SharePoint integration (and the WordPerfect Office IFilter) when WordPerfect Office X7 is installed.

If desired, you can deploy the following customized settings:

- **disabling of WordPerfect toggle for displaying files in Internet Explorer:**
  Use the **WPDVIEWLOCK** public property (see page 16).

- **home page for the Open File dialog box:**
  Use the **HomePageURL** registry key (see page 32).

To extend the SharePoint functions of WordPerfect — for example, to automate multiple check-ins, multiple check-outs, or file-comparison reports — you can use PerfectScript™ macros. The following commands (fully detailed in the installed Macro Help file, psh.chm) will be of interest.

<table>
<thead>
<tr>
<th>To do the following</th>
<th>Use the following commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>Directly access the document-management engine directly, bypassing its UI</td>
<td>DocMgmtCheckin  &lt;/br&gt; DocMgmtCheckout  &lt;/br&gt; DocSetWorkingFolder  &lt;/br&gt; DocMgmtUndoCheckout</td>
</tr>
<tr>
<td>Specify command arguments (macro-specific values)</td>
<td>DocMgmtGetResultCode  &lt;/br&gt; DocMgmtGetResultDesc  &lt;/br&gt; DocMgmtSetArg</td>
</tr>
<tr>
<td>Specify document properties</td>
<td>DocPropertyGetCount  &lt;/br&gt; DocPropertyGetName  &lt;/br&gt; DocPropertyGetType  &lt;/br&gt; DocPropertyGetValue  &lt;/br&gt; DocPropertyRemove  &lt;/br&gt; DocPropertyRemoveAll  &lt;/br&gt; DocPropertySet</td>
</tr>
</tbody>
</table>
Stage 2: Copying the contents of the DVD or extracting the ESD to the server

After preparing for deployment, you're ready to copy (DVD) or extract (ESD) media to the server.

You can modify certain aspects of the media you copied or extracted to the server or its setup. If you want to support multiple installation types, you can create multiple versions of the media you copied or extracted to the server.

Finalizing media on the server

This section describes recommended steps to take before deploying from the media copied to the server.

Optionally, you can finalize the media you copied or extracted to the server in the following ways:

- Customize the registry settings you want to deploy (see page 31).

Applying patches

To avoid deploying the software twice, you may want to check for software updates and apply them as necessary. For details, see page 20.

Supporting OOXML

You can deploy support for saving to Office Open XML (OOXML) format from within WordPerfect Office X7.

To deploy support for saving to OOXML

1. After copying the DVD or extracting the ESD content to the server, open the Setup folder.
2. Create a new folder, and name it MSPack.
4. Save FileFormatConverters.exe to the MSPack folder.

All future workstation installations from this location will automatically allow users to save to the Microsoft 2007/2010 format.

Configuring BDE

For WordPerfect and Quattro Pro® to function properly, you must ensure that the network folder settings for the Borland® Database Engine (BDE) point to a folder for which all users have write and delete permissions.
To adjust the Borland Database Engine

1. Log on to the server console as an administrator.
2. From the Windows Control Panel, open the BDE Administrator.
3. Click the Configuration tab.
4. Expand the Configuration tree, and navigate to the following: \Drivers\Native\PARADOX
5. In the right pane, click the field to the right of the NET DIR entry.
6. Click ..., and browse to the location of the desired network folder.
   All users must have write and delete permissions for this folder.
7. Click Object ▶ Apply.
8. Click OK to confirm the save, and then click OK again when you are prompted to restart all Borland Database Engine applications.

Testing
You may want to test on a small subset of workstations before rolling it out to your entire organization.
Stage 3: Installing the software

After copying the contents of the DVD or extracting the ESD to the server, you can use it to install the software on the workstations in one of two ways:

- manually, by having users “pull” the software to their own workstations
- automatically, by “pushing” the software to the workstations on their users’ behalf

In this stage

- Pulling the software
- Pushing the software

Pulling the software

If users have both access to the server and administrator-level rights to their workstations, they can install (or “pull”) the software themselves. To do this, they run the setup from the media you copied or extracted to the server.

In this section

- Preparing for pull installation
- Carrying out a pull installation

Preparing for pull installation

To ensure that the pull-installation process runs as smoothly as possible, take the time to prepare for it.

Requirements

- Confirm that each workstation meets the minimum requirements for the software (see “Workstation requirements” on page 3).
- Confirm that each workstation user has read-only access to the media you copied or extracted to the server and administrator-level access to the workstation (see also “Workstation setup” on page 4).

Recommendations

- Map the workstations to the media you copied or extracted to the server, and set the workstations to log in to that server location at startup. Doing so ensures that users are always connected this content.
- Confirm that all workstations are running the latest version of Microsoft Windows Installer. Doing so simplifies the installation process.

Carrying out a pull installation

Users pull the software to their workstations by running the setup from the media you copied or extracted to the server.
The degree of user interaction required by the setup depends on how you’ve customized the media you copied or extracted to the server and the deployment process.

If you prefer to restrict user customization, you may want to offer multiple versions of the media you copied or extracted to the server — one per set of installation options.

**To pull the software to a workstation**

1. Browse to the location of the media you copied or extracted to the server, and double-click `Setup.exe`.
2. Carry out the installation, specifying any desired options, by following the on-screen instructions.
   
   For best results, limit the installation path to 70 characters.

---

**Pushing the software**

To “push” the software from the media you copied or extracted to the server to the workstations, you must write a command line that includes the following:

- the filename of the setup you want to use
- any desired switches, to control how the setup runs
- any desired public properties, to specify installation settings

Using this command line, you can install the software on the workstations by using any supported push method.

**In this section**

- Specifying the setup file .............................................. 9
- Using switches .......................................................... 10
- Using public properties ............................................... 11
- Running your command line ................................. 16

**Specifying the setup file**

The most important item to specify in your command line is the executable file for the setup: the `Setup.exe` file on the server you want to use:

```
\server\path\Setup.exe
```

If your path contains spaces, you must place quotation marks around it:

```
"\server\path containing spaces\Setup.exe"
```

If your network requires deployment via `msiexec.exe` instead of `Setup.exe`, see page 33.
Using switches

By using switches in your command line, you can control the setup process. Listed in this section are the switches most commonly used when installing the software.

For general information on switches, along with details on switch syntax, please “Switches” in the Corel Beginner’s Guide to Network Deployment.

For a list of all command-line switches for Microsoft Windows Installer, please see the Microsoft website.

/l Event logging

Use /l to log installation events.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>What it logs</th>
</tr>
</thead>
<tbody>
<tr>
<td>i</td>
<td>Status messages</td>
</tr>
<tr>
<td>w</td>
<td>Nonfatal warnings</td>
</tr>
<tr>
<td>e</td>
<td>All error messages</td>
</tr>
<tr>
<td>a</td>
<td>Initiated actions</td>
</tr>
<tr>
<td>r</td>
<td>Action-specific records</td>
</tr>
<tr>
<td>u</td>
<td>User requests</td>
</tr>
<tr>
<td>m</td>
<td>Error messages for out-of-memory warnings or fatal exits</td>
</tr>
<tr>
<td>o</td>
<td>Error messages for insufficient hard-disk space during server installation</td>
</tr>
<tr>
<td>p</td>
<td>Terminal properties</td>
</tr>
<tr>
<td>*</td>
<td>All of the above, in a single log file</td>
</tr>
</tbody>
</table>

NOTE: Alternatively to /l*, you can use /log.

The default parameters for /l are iwearmo (/iwearmo "c:\install Logs.txt").

If you want to specify a path for the log file, use the following syntax:

/l "path"

If you do not specify a path and filename, the log file is created in the current user’s temporary (Temp) folder.

In the following example, the /l switch (with default parameters) is used to log installation events in the specified file:

\\server\path\Setup.exe /l "C:\install.txt"
/q Limited setup UI

Use /q to limit the amount of setup UI encountered during installation.

You can use /q to prevent users from entering their own registration information, to help enforce specific installation options, or even to perform silent installations (in which no setup UI is visible whatsoever).

<table>
<thead>
<tr>
<th>Parameter</th>
<th>What the user sees during installation</th>
</tr>
</thead>
<tbody>
<tr>
<td>n</td>
<td>No UI whatsoever. Errors are logged in a file that you can control by using /l (see page 10). This is the default parameter. NOTE: Alternatively to /qn, you can use /quiet.</td>
</tr>
<tr>
<td>b</td>
<td>Basic UI: a progress bar and a Cancel button. If the user pushes the Cancel button, the installation is rolled back upon confirmation. NOTE: Alternatively to /qb, you can use /passive.</td>
</tr>
<tr>
<td>b!</td>
<td>Basic UI: only a progress bar. The user cannot cancel the installation.</td>
</tr>
<tr>
<td>b+</td>
<td>Basic UI: a progress bar and a Cancel button. If the user pushes the Cancel button, the installation is rolled back (without first prompting for confirmation).</td>
</tr>
<tr>
<td>r</td>
<td>Reduced UI: A progress bar, along with a page containing information about the installation. The user can cancel the installation.</td>
</tr>
<tr>
<td>f</td>
<td>Full UI</td>
</tr>
</tbody>
</table>

The default parameter for /q is n.

In the following example, all setup UI is suppressed, and any errors are recorded in the specified log file:

```
\server\path\Setup.exe /q /l "C:\Logs\My_Log.txt"
```

/? Help

The /? switch (or /help) displays Help for the setup.

Using public properties

By using public properties in your command line, you can specify installation settings. Listed alphabetically in this section are the properties most commonly used during software installation.

For general information on public properties, along with details on property syntax, please see the Corel Beginner’s Guide to Network Deployment.
For a list of all command-line properties for Microsoft Windows Installer, please see the Microsoft website.

**ADDLOCAL** Installing specific components

For details on this scenario, see the following topics in the appendix:
- “Deploying specific features” on page 25

**ASSOCIATE_DOCFILES** Associate DOC files with WordPerfect

You can associate all Microsoft® Word (DOC) files with WordPerfect by using the following property:

```
ASSOCIATE_DOCFILES=1
```

**ASSOCIATE_PPTFILES** Associate PPT files with Presentations

You can associate all Microsoft® PowerPoint® (PPT) files with Presentations by using the following property:

```
ASSOCIATE_PPTFILES=1
```

**ASSOCIATE_XLSFILES** Associate XLS files with Quattro Pro

You can associate all Microsoft® Excel® (XLS) files with QuattroPro by using the following property:

```
ASSOCIATE_XLSFILES=1
```

**DESKTOPSHORTCUTS** Opting out of desktop shortcuts

You can prevent the installation of desktop shortcuts by using the following property:

```
DESKTOPSHORTCUTS=0
```

**IGNORE_LAUNCH_CONDITIONS** Suppressing the software-requirements check

By default, the setup checks whether the computer meets the minimum software requirements (see page 3) before proceeding with the installation. To suppress this check, use the following property:

```
IGNORE_LAUNCH_CONDITIONS=1
```

**FORCENOSHOWLIC** Suppressing the EULA prompt

If the software is installed silently (see page 11), each workstation user will be prompted to accept the End-User License Agreement (EULA) at first start-up. To suppress the EULA prompt on the workstations, use the following property:

```
FORCENOSHOWLIC=1
```
If you choose to suppress the EULA prompt on the workstations, you are accepting the terms of the EULA on behalf of your organization and all users. Deployed installations will not prompt users to review the license agreement.

**INSTALL_APP** Installing only specified programs

By default, WordPerfect Office X7 installs WordPerfect, Quattro Pro, and Presentations™. To install only one (or two) of these programs, use the **INSTALL_APP** property with one of the following values (or two comma-separated values).

<table>
<thead>
<tr>
<th>Value</th>
<th>What it installs</th>
</tr>
</thead>
<tbody>
<tr>
<td>presentations</td>
<td>Presentations</td>
</tr>
<tr>
<td>quattropro</td>
<td>Quattro Pro</td>
</tr>
<tr>
<td>wordperfect</td>
<td>WordPerfect</td>
</tr>
</tbody>
</table>

In the following example, only WordPerfect is installed:

```
Setup.exe INSTALL_APP=wordperfect
```

In the following example, only WordPerfect and Quattro Pro are installed:

```
Setup.exe INSTALL_APP=wordperfect,quattropro
```

You can also install specific program features. For details, see page 25.

**INSTALLDIR** Customizing the installation path

When deploying from the media you copied or extracted to the server, use the following public property to customize the installation path of the software:

```
INSTALLDIR="path"
```

For best results, do not end the path with a backslash (`\`).

**INSTALL_IFILTER** Managing IFilter installation

You can prevent the installation of the WordPerfect Office IFilter by using the following property:

```
INSTALL_IFILTER=0
```

**MIGRATE_PRODUCT** Migrating user settings during upgrade

When upgrading from a previous version of WordPerfect Office, you can use the **MIGRATE_PRODUCT** property to migrate user settings. For details on upgrading to WordPerfect Office X7, see page 14.
**REBOOT**

Handling reboots

The **REBOOT** property is used with one of the following values to specify how the installation process handles any required reboots.

<table>
<thead>
<tr>
<th>Value</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>Force (or F)</td>
<td>Prompts for reboot after installation. If the setup UI is suppressed, the computer is automatically rebooted after installation. NOTE: Alternatively to <strong>REBOOT=Force</strong>, you can use the <code>/forcerestart</code> switch.</td>
</tr>
<tr>
<td>Suppress (or S)</td>
<td>Prompts for reboot during installation (if required), but reboots automatically after installation. If the setup UI is suppressed, all required reboots are automatic. NOTE: Alternatively to <strong>REBOOT=Suppress</strong>, you can use the <code>/promptrestart</code> switch.</td>
</tr>
<tr>
<td>Really Suppress (or R)</td>
<td>Suppresses all reboots and all reboot prompts, both during and after installation. NOTE: Alternatively to <strong>REBOOT=ReallySuppress</strong>, you can use the <code>/norestart</code> switch.</td>
</tr>
</tbody>
</table>

**SERIAL NUMBER**

Inputting your serial number

To input your assigned serial number, use the following property:

```
SERIALNUMBER=serial number
```

You must type the serial number without any spaces.

**SPLITTABLEROWS**

Splitting table rows

By default, WordPerfect disables the setting for splitting table rows across pages (Table ➤ Format ➤ Row ➤ Divide row across pages) — in part, to ensure that footnotes can be added within tables. To enable this setting on the workstations, use the following property:

```
SPLITTABLEROWS=1
```

Enabling this setting corresponds to writing the registry key `WPTablesSpanRows`, while disabling it corresponds to writing `WPTablesSpanRows_defaultOff`. See page 31 for details on registry keys.

**UPGRADE_PRODUCT** and **UPGRADE_PRODUCT_DEFAULT**

Upgrading to WordPerfect Office X7

To upgrade to WordPerfect Office X7 and migrate user settings from a previous version of WordPerfect Office, you must use several public properties together.
First, you must use the following property to specify which version (or versions) of WordPerfect Office to search for:

\[ \text{UPGRADE} \text{PRODUCT} = \text{value} \]

The \text{UPGRADE} \text{PRODUCT} property is used with one (or more) of the following (comma-separated) values:

<table>
<thead>
<tr>
<th>Value</th>
<th>What it searches for</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Any installed version of WordPerfect Office</td>
</tr>
<tr>
<td>16</td>
<td>WordPerfect Office X6</td>
</tr>
<tr>
<td>15</td>
<td>WordPerfect Office X5</td>
</tr>
<tr>
<td>14</td>
<td>WordPerfect Office X4</td>
</tr>
<tr>
<td>13</td>
<td>WordPerfect Office X3</td>
</tr>
<tr>
<td>12</td>
<td>WordPerfect Office 12</td>
</tr>
</tbody>
</table>
| 11    | WordPerfect Office 11  
\text{NOTE: You cannot upgrade from WordPerfect Office 11 without first uninstalling Paradox® (if included).} |
| None  | Nothing — upgrade feature is disabled |

Next, you must use the following public property to specify whether to upgrade the previous version (or versions) of WordPerfect Office found:

\[ \text{UPGRADE} \text{PRODUCT} \text{_DEFAULT} = \text{value} \]

The \text{UPGRADE} \text{PRODUCT} \text{_DEFAULT} property is used with one of the following values:

<table>
<thead>
<tr>
<th>Value</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>On (or any other value)</td>
<td>Automatically upgrades all installed versions of WordPerfect Office</td>
</tr>
<tr>
<td>Off</td>
<td>Does not automatically upgrade any installed version of WordPerfect Office</td>
</tr>
</tbody>
</table>

To upgrade to WordPerfect Office X7, you must use \text{UPGRADE} \text{PRODUCT} and \text{UPGRADE} \text{PRODUCT} \text{_DEFAULT} together. Using only one property causes it to be ignored altogether.

Finally, you can use the following public property to migrate user settings from a previous version of WordPerfect Office:

\[ \text{MIGRATE} \text{PRODUCT} = \text{value} \]

The \text{MIGRATE} \text{PRODUCT} property is used with one of the following values:
In the following example, all installed versions of WordPerfect Office are automatically upgraded to WordPerfect Office X7, and user settings are migrated from the latest installed version of WordPerfect Office:

\[
\begin{align*}
\text{UPGRADE\_PRODUCT} &= \text{All} \\
\text{UPGRADE\_PRODUCT\_DEFAULT} &= \text{On} \\
\text{MIGRATE\_PRODUCT} &= \text{Latest}
\end{align*}
\]

In the following example, only WordPerfect Office 12 and WordPerfect Office X3 are searched for — but they are not automatically upgraded to WordPerfect Office X7; in addition, user settings are migrated from WordPerfect Office 12:

\[
\begin{align*}
\text{UPGRADE\_PRODUCT} &= 12,13 \\
\text{UPGRADE\_PRODUCT\_DEFAULT} &= \text{Off} \\
\text{MIGRATE\_PRODUCT} &= 12
\end{align*}
\]

### WPDVIEWLOCK

**Locking the display of WPD files in Internet Explorer**

By default, users have access to the following WordPerfect setting: Tools ➤ Settings ➤ Files ➤ Allow Internet Explorer to display WPD files. To make this setting unavailable, use the following property:

\[
\text{WPDVIEWLOCK}=1
\]

Making this setting unavailable corresponds to writing the registry key WPWinViewerLocked. For details on registry keys, see page 31.

### Running your command line

Your command line can be used to push the software to the workstations through any of the following:

- a batch file — see the Microsoft website for details
- a GPO — see the Group Policy SDK for details
- a third-party push technology — see the manufacturer’s documentation for details
For many administrators, using a third-party push technology is the preferred push method. This section offers general guidelines on using a few such technologies.

**SCCM**

At the time of this writing, Corel has verified support for Microsoft® System Center Configuration Manager (SCCM) only insofar as its Microsoft Systems Management Server (SMS) components.

For complete information on using SCCM, please see the Microsoft website.

**SMS**

For deployment to the workstations on a “per-system” basis using package definition files (or “packages”), WordPerfect Office X7 supports the use of Microsoft Systems Management Server (SMS).

You can create a package from scratch — or you can create one from the existing SMS file included with WordPerfect Office X7 (in the Administrator folder on the installation disc or the media you copied or extracted to the server).

For complete information on using SMS files, please refer to your resource kit for Microsoft Systems Management Server.

The recommendations posted on the Microsoft website have not been tested with WordPerfect Office X7 and must therefore be used at your discretion.

**IntelliMirror**

For deployment to the workstations, WordPerfect Office X7 supports the use of the IntelliMirror technology, which is part of the Windows Server 2003, Windows Server 2008, Windows Server 2008 R1, and Windows Server 2008 R2 operating systems.

“Per-user” installations are not supported.

To make deployment with IntelliMirror as easy as possible, WordPerfect Office X7 includes a ZAP file (in the Administrator folder on the installation disc or the media you copied or extracted to the server).

For complete information on IntelliMirror, please see the Microsoft website.
Stage 4: Maintaining the installations

An important part of administering a network is maintaining the software installed on its workstations.

In this stage
- Repairing the software ........................................... 18
- Modifying the software ............................................. 20
- Updating the software ............................................. 20
- Removing the software ............................................ 22
- Troubleshooting the software ................................. 24

Repairing the software

Repairing the software lets you install (or reinstall) missing (or corrupted) components. You can repair a single installation of the software by using the Windows Control Panel on that workstation, or you can repair multiple workstation installations by using a command line.

Repairing a single installation

You can use the Windows Control Panel to repair a single installation.

To repair an installation with the Windows Control Panel
1. In the Windows Control Panel, display the list of currently installed programs, and choose the program from the list.
2. Click Uninstall/Change (for Windows 8.1, Windows 8, or Windows 7) or Change/Remove (for Windows XP).
3. Enable the Repair option, and then click Repair.
4. Follow the on-screen instructions.

Repairing multiple installations

You can use a command line to repair multiple installations at a time.

/f Basic repair

Use the /f switch with the Setup.exe file from the media you copied or extracted to the server:

\\server\path\Setup.exe /f
You cannot use the `/f` switch with public properties. For greater control over the repair process, use the `REINSTALL` and `REINSTALLMODE` properties instead of `/f`.

The `/f` switch has the following parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>p</td>
<td>Reinstalls missing files</td>
</tr>
<tr>
<td>o</td>
<td>Reinstalls missing files and files older than current version</td>
</tr>
<tr>
<td>e</td>
<td>Reinstalls missing files and files equal to or older than current version</td>
</tr>
<tr>
<td>d</td>
<td>Reinstalls missing files and files different from current version</td>
</tr>
<tr>
<td>a</td>
<td>Reinstalls all files</td>
</tr>
<tr>
<td>u</td>
<td>Reinstalls all required user-specific registry keys: <code>HKEY_CURRENT_USER</code>, <code>HKEY_USERS</code></td>
</tr>
<tr>
<td>m</td>
<td>Reinstalls all required computer-specific registry keys: <code>HKEY_LOCAL_MACHINE</code>, <code>HKEY_CLASSES_ROOT</code></td>
</tr>
<tr>
<td>s</td>
<td>Reinstalls all existing shortcuts</td>
</tr>
<tr>
<td>v</td>
<td>Runs from the source files and re-caches the local package</td>
</tr>
</tbody>
</table>

The default parameters for `/f` are `oums`.

Advanced repair

For greater control over how the software is repaired, use the `REINSTALL` and `REINSTALLMODE` public properties together.

<table>
<thead>
<tr>
<th>Property</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>REINSTALL=ALL</code></td>
<td>Reinstalls all program features. If you prefer to reinstall only specific features (see page 25 for a list), use the following syntax: <code>REINSTALL=Feature</code></td>
</tr>
<tr>
<td><code>REINSTALLMODE=type</code></td>
<td>Specifies the type of reinstallation to perform. The values for this property are the same as the parameters for the <code>/f</code> switch, so its default values are <code>oums</code>.</td>
</tr>
</tbody>
</table>
Modifying the software

Modifying the software lets you change which program features are installed. You can modify a single installation of the software by using the Windows Control Panel on that workstation, or you can modify multiple workstation installations by using a command line.

Modifying a single installation

You can use the Windows Control Panel to modify a single installation.

To modify an installation with the Windows Control Panel
1 In the Windows Control Panel, display the list of currently installed programs, and choose the program from the list.
2 Click Uninstall/Change (for Windows 8.1, Windows 8, or Windows 7) or Change/Remove (for Windows XP).
3 Enable the Modify option, and then click Next.
4 Follow the instructions that appear.

Modifying multiple installations

You can use a command line to modify multiple installations at a time.

REINSTALL and REINSTALLMODE

Adding features
You can use the REINSTALL and REINSTALLMODE properties to add program features. For details on these properties, see page 19.

REMOVE
Removing features
You can use the REMOVE public property to remove a program feature:

REMOVE=Feature
For more than one feature, use a comma-separated list:

REMOVE=Feature1,Feature2
For a list of available features, see page 25.

Updating the software

Corel periodically releases Microsoft patch (MSP) files — or “patches” — for its products. Installing patches helps keep the software up-to-date.
In this guide, **Patch.exe** is a placeholder for the filename of the patch. The actual filename varies with each patch.

### Locating patches

Many network administrators keep their software up-to-date by monitoring the Corel Support Services website ([www.corel.com/support](http://www.corel.com/support)). When a patch is made available, these administrators download it and carry out the patching process themselves.

In this guide, `\server\path\Patch.exe` is a placeholder for the location and filename of the downloaded patch.

If you prefer to have workstation users patch the software for themselves, you can set up the media you copied or extracted to the server to enable the automatic detection of available patches.

### Applying patches

After locating and downloading a patch, you can apply it to the media you copied or extracted to the server and then use the updated media to patch the installed software.

**Patching**

You can apply a patch to the media you copied or extracted to the server. Optionally, you can begin by extracting the patch files to a specified location.

**To extract the patch files to a specified location**

To extract the patch files to a specified location (instead of the default `Temp` folder), use the following command-line syntax:

```
\server\path\Patch.exe /extract_all "location"
```

Be sure to apply all extracted patch files to the media you copied or extracted to the server. Applying only some of the patch files may cause the installations to function incorrectly.

**To apply the patch files**

Use a command line that includes the executable file for the patch and the `/a` switch:

```
\server\path\Patch.exe /a
```

If necessary, you can include the location of the media you copied or extracted to the server:

```
\server\path\Patch.exe /a
"\server\path\Setup.exe"
```
Workstation patching  After patching the media you copied or extracted to the server, you can deploy the update to the workstations.

To patch the workstations

Use the following command-line syntax:

```
\server\path\Setup.exe REINSTALL=ALL
```

By default, the `REINSTALLMODE=oums` property is applied. For best results, you may want to specify `REINSTALLMODE=vdm`:

```
\server\path\Setup.exe REINSTALL=ALL
   REINSTALLMODE=vdm
```

For details on `REINSTALL` (and `REINSTALLMODE`), see page 19.

To silently patch the workstations

Use the following command line:

```
\server\path\Patch.exe /s
```

For best results, avoid silently patching the workstations.

Removing the software

You can remove the software from your network. Uninstalling the software cleanly is crucial when the time comes to upgrade to a newer version.

Removal of media from the server

You cannot automate the removal of media you copied or extracted to the server. Instead, you must manually delete it from the server.

For best results with deleting, begin by doing the following:

• Make sure that the programs to be removed — and their associated files — are not currently in use on the workstations.

• If you are using Windows Terminal Server, make sure that all users are logged off.

The only way to re-cover a deleted media is to re-create it by re-running the setup.

Workstation removal

You can remove a single installation of the software by using the Windows Control Panel on that workstation, or you can remove multiple workstation installations by using a command line.

Removing a single installation

You can use the Windows Control Panel to remove a single installation.
**To remove an installation with the Windows Control Panel**

**Windows 8.1 or Windows 8**
1. With a mouse, move your pointer into the upper-right or lower-right corner, and then move it up or down to click **Search**.
2. Type **Control Panel** in the search box, and press **Enter**.
3. Click **Uninstall a program** under **Programs**.
4. Double-click **WordPerfect Office X7** on the Uninstall or change a program page.
5. Follow the uninstallation instructions in the setup.
   - If you want to remove user files (such as presets, user-created fills, and customized files), enable the **Remove user files** check box.

**Windows 7**
1. On the Windows taskbar, click **Start ➤ Control Panel**.
2. Click **Uninstall a program** under **Programs**.
3. Double-click **WordPerfect Office X7** on the Uninstall or change a program page.
4. Follow the uninstallation instructions in the setup.
   - If you want to remove user files (such as presets, user-created fills, and customized files), enable the **Remove user files** check box.

**Windows XP**
1. On the Windows taskbar, click **Start ➤ Control Panel**.
2. Double-click **Add or Remove Programs**.
3. Choose **WordPerfect Office X7** from the list in the **Add or Remove Programs** dialog box, and click **Change/Remove**.
4. When the setup appears, enable the **Remove** option.
5. Click **Next** to proceed with the uninstallation.

If you want to remove user files (such as presets, user-created fills, and customized files), enable the **Remove user files** check box. **Removing multiple installations**

You can use a command line to remove multiple installations at a time.

/x Basic removal

You can use the /x switch (or the /uninstall switch) to silently remove the software:

```plaintext
\server\path\Setup.exe /x
```

**Advanced removal**

If you want more control over the removal process, use the following two public properties.
## Troubleshooting the software

For help troubleshooting any issues with the software, please visit the Corel® Knowledge Base™ (www.corel.com/knowledgebase), an online repository of FAQs and articles.

<table>
<thead>
<tr>
<th>Property</th>
<th>What it does</th>
</tr>
</thead>
<tbody>
<tr>
<td>REMOVE=ALL</td>
<td>Removes all features</td>
</tr>
<tr>
<td>REMOVEUSERFILES=value</td>
<td>Specifies whether to remove user files:</td>
</tr>
<tr>
<td></td>
<td>• 0 — no</td>
</tr>
<tr>
<td></td>
<td>• 1 — yes</td>
</tr>
</tbody>
</table>
Appendix: Specialized deployment scenarios

If you require a more specialized deployment scenario, the supplementary topics in this appendix may be of interest to you.

In this appendix

- Deploying specific features ........................................... 25
- Deploying macros and templates ................................... 26
- Working with MST files .................................................. 30
- Working with registry keys ............................................. 31
- Deploying customized installation settings ...................... 33
- Deploying the software with msiexec.exe ......................... 33

Deploying specific features

When performing a basic or silent installation with the /q switch (see page 11), you may want to use the ADDLOCAL property to specify which software features to install. You can specify a single feature:

```
ADDLOCAL=Feature
```

Or you can specify a comma-separated list of components:

```
ADDLOCAL=Feature1,Feature2
```

You can even specify all features:

```
ADDLOCAL=ALL
```

If you want to install nearly all features, naming them individually would be quite tedious. In this scenario, you can use the REMOVE public property to specify the features to subtract from ADDLOCAL=ALL:

```
ADDLOCAL=ALL REMOVE=Feature1,Feature2
```

Feature names are case-sensitive.

Specifying software features by feature name

You can specify individual WordPerfect Office X7 components by their feature name.

Some editions of the software do not include certain features listed in this section.

Feature names are case-sensitive.

<table>
<thead>
<tr>
<th>WPO component</th>
<th>Feature name</th>
</tr>
</thead>
<tbody>
<tr>
<td>WordPerfect</td>
<td>WP</td>
</tr>
</tbody>
</table>
Deploying macros and templates

Macros and templates make it easy to customize solutions for your organization. You can customize a macro that carries out a set of actions, assign that macro to a shortcut key, and save the macro and its shortcut key to a template, so that users who work from that template have access to the macro and its shortcut key.

If you want, you can make customized macros available to workstation users by storing them in a template. In fact, you can store every macro in the default template file (wp17$$.$$wpt, where $$ is the default writing-tools language), and then deploy that default template file to each user’s machine.

Template macros are not transferred to documents based on that template. Consequently, template macros are available only when their template is available, so it is important to choose a final location for a template before you put it into active use.

WordPerfect Office X7 supports using a centralized, network-based repository for storing your macros and templates. However, you can deploy macros and templates if preferred.

**Deployment methods**

You can deploy macros and templates as you would any other file:
- by running a specialized command line, such as with a push technology (see page 9)
- by using an MST file (see page 30)
Installing macros and templates

At any point, users can install macros and templates to their workstations.

Template macros set as read-only do not run properly.

Default items

By default, WordPerfect Office installs macros and templates at the following location (where \textit{X:} is the drive where WordPerfect Office is installed, and where \textit{$\$$} is the installation language):

\begin{verbatim}
X:\Program Files\Corel\WordPerfect Office X7\Languages\$\Template\Custom ProgramName templates
\end{verbatim}

User-created items

User-created macros and templates are stored at the following location (where \textit{X:} is the drive where the operating system is installed):

- Windows 8.1, Windows 8, and Windows 7:
  \begin{verbatim}
  X:\Users\UserName\AppData\Roaming\Corel\PerfectExpert\17\Language\Custom ProgramName Templates
  \end{verbatim}

- Windows XP:
  \begin{verbatim}
  X:\Documents and Settings\UserName\Application Data\Corel\PerfectExpert\17\Language\Custom ProgramName Templates
  \end{verbatim}

If a new WordPerfect template doesn’t appear after it is installed to the PerfectExpert or saved to the \textit{Custom WP Templates} folder, you must refresh the PerfectExpert.

To refresh the PerfectExpert

1. In WordPerfect X7, click File \textit{$\Rightarrow$} New from project.
2. Click the Create new tab.
3. Click Options, and then click Refresh projects.
   - If the new template still does not appear, try changing the category from \{WordPerfect\} to \textit{Custom WP templates}.

Migrating macros and templates

Macros and templates can be migrated from an earlier version of WordPerfect.

Macro migration

Most macros from a previous version of WordPerfect can be recompiled to work in WordPerfect X7.

By default, warnings are not displayed for obsolete tokens because they do not interfere with the functioning of most macros. You can choose to display these warnings, however.
If you want to store your organization’s macros in a centralized repository, you can set WordPerfect to compile and run all macros locally (that is, from the user’s temporary folder). For details, see “To specify how WordPerfect runs and compiles macros” in the WordPerfect Help.

**To manually migrate a macro**

1. Copy the macro to your template folder (if you haven’t already done so).
3. Click **Tools** ➤ **Macro** ➤ **Edit**.
4. Navigate to the macro, select it, and then click **Edit**.
5. Click the end of the first line.
6. Press the **Spacebar**, and then press **Backspace**.
7. Click **Save & compile**.

The macro is recompiled for WordPerfect X7. Be sure to correct any errors incurred — often, such errors result from updated or removed commands.

**To display warnings for obsolete tokens**

1. Click **Start** ➤ **Programs** ➤ **WordPerfect Office X7** ➤ **Utilities** ➤ **PerfectScript**.
2. In PerfectScript, click **Tools** ➤ **Settings**.
3. On the Compile page, enable the **Warn when using unsupported features** check box.
4. Click **Apply** and then click **OK**.

**Template migration**

Default templates — and most other templates — from previous versions of WordPerfect can be migrated to WordPerfect X7.

Using a migrated template can prevent WordPerfect X7 from displaying its new features. For best results, migrate only the desired template components (toolbars, menus, keystroke assignments, and so on).

When you open a template, WordPerfect checks whether the template is missing default menu commands. You can merge missing menu commands into a template by following the procedure “To merge default menu commands into a template” in the WordPerfect Help.

**To manually migrate template components**

1. Do one of the following:
   - Copy the source templates to your template folder for **WordPerfect Office X7**, and then start **WordPerfect X7**.
   - Start **WordPerfect X7**. Click **Tools** ➤ **Settings**, and then click **Files**. On the Template page, use the **Additional template folder** box to specify the location of the source templates.
2 Click Tools ➤ Settings, and then click Customize.

3 Click the tab for the template component you want to migrate.

4 Click Copy, and then do the following:
   - From the Template to copy from list box, choose the source template.
   - From the Select toolbars to copy list, select the component to migrate. Hold down CTRL to select multiple components.
   - From the Template to copy to list box, choose the target template. (If you want, you can choose the default template.)
   - Click OK.

You are prompted to rename a component if another component by that name exists. To distinguish between similar components, you may want to append version numbers to their names.

5 To apply the new component, enable its check box.

6 To migrate each additional component, repeat steps 3 to 5.

**Migrating user settings**

In push-installation scenarios, administrators can migrate users’ customized settings automatically (see page 14). In pull-installation scenarios, users themselves can choose to migrate their settings.

**QuickWords list**

Locate the QuickWords™ list file that belongs to the previous version, and use it to replace the QuickWords list file for WordPerfect X7. The QuickWords list file for WordPerfect X7 is saved at the following location (where X: is the drive where Windows is installed and $$ is the default writing-tools language).

- Windows 8.1, Windows 8, and Windows 7:
  X:\Users\UserName\AppData\Roaming\Corel\PerfectExpert\17\Language\Custom WP Templates\QW17$$\WPT

- Windows XP:
  X:\Documents and Settings\UserName\Application Data\Corel\PerfectExpert\17\Language\Custom WP Templates\QW17$$\WPT

**QuickCorrect list**

Locate the QuickCorrect™ list file that belongs to the previous version, and use it to replace the QuickCorrect list file for WordPerfect X7. The QuickCorrect list file for WordPerfect X7 is saved at the following location (where X: is the drive where Windows is installed and $$ is the default writing-tools language).

- Windows 8.1, Windows 8, and Windows 7:
  X:\Users\UserName\Documents\Corel User Files\WT17$$\UWL

- Windows XP:
  X:\Documents and Settings\UserName\My Documents\Corel User Files\WT17$$\UWL
**Address Books**

First, export the Address Books from the previous version of WordPerfect to an ABX (version 8) or TXT file format. Then, in WordPerfect X7, create an empty Address Book and import the ABX or TXT file into it.

Address Book records can contain hard returns. For example, this can happen when there are two lines of the street address. If an Address Book does not properly import from a text file, review the contents of the file with a text editor, and remove any extraneous hard returns.

---

**Working with MST files**

If you want to apply a Microsoft transformation (MST) file to the setup, simply apply it to your command line.

By default, MST files are applied to the `Setup.msi` file for the setup.

**To apply a transformation to the setup**

1. Store the MST file in the location where you copied or extracted media to the server.
2. Use the `TRANSFORMS` property to specify that MST file, as shown here (where `MST` is the filename of the MST file):

   ```
   Setup.exe TRANSFORMS="MST"
   ```

   If the MST file is not in the same folder as `Setup.exe`, `MST` must specify the full path and filename of the MST file.

**Applying a transformation to a specific MSI file**

To apply an MST file to a specific MSI file, use the following syntax (where `MSI` is the filename of the MSI file, not including its extension; and where `MST` is the filename of the MST file, including its extension):

```
Setup.exe TRANSFORMS_MSI="MST"
```

If the MST file is not in the same folder as the MSI file, `MST` must specify the full path and filename of the MST file.

**Example 1**

To apply `my_wp.mst` to `WP.msi` (in the same folder), use the following syntax:

```
Setup.exe TRANSFORMS_WP="my_wp.mst"
```

**Example 2**

To apply `MyTransform.mst` to `ENPExp.msi` (in the same folder), use the following syntax:

```
Setup.exe TRANSFORMS_ENPExp="MyTransform.mst"
```
Troubleshooting MST files

If you have trouble applying an MST file, do the following:

- Check the syntax of your command line — in particular, the path to the MST file.
- Check your permissions.
- Make sure that the MST file was created correctly.
- Check the associated MSI files.

For additional help with MST files, contact Corel Support Services (www.corel.com/support). Please note, however, that charges will apply.

Working with registry keys

After copying or extracting media to the server, you may want to edit its registry keys for deployment to the workstations. By doing so, you can avoid having to manually configure the registry keys of each individual workstation installation of the software.

Deploying program defaults

When a workstation user first starts a WordPerfect Office X7 program, settings for that program are pushed from HKEY_LOCAL_MACHINE registry keys to HKEY_CURRENT_USER keys for that user. If you want to mandate the default program settings for all workstation users, you can deploy the HKEY_LOCAL_MACHINE registry keys for those settings.

You can use a local installation of WordPerfect Office X7 to determine which HKEY_LOCAL_MACHINE registry keys are affected by a specific program setting. Open the program, and specify the setting that you want to deploy to the workstations. This setting is saved as a value for a specific registry key at the following location:

HKEY_CURRENT_USER\Software\Corel\ProgramName\17

To deploy this program setting to all workstation users, apply it to the registry file (or MSI table) for the media you copied or extracted to the server as a value for the corresponding HKEY_LOCAL_MACHINE registry key at the following location:

HKEY_LOCAL_MACHINE\SOFTWARE\Corel\Setup\WordPerfect Suite\17\Migrate\Software\Corel\ProgramName\17

The method described in this section can be used to deploy almost any registry key for WordPerfect Office X7. Two common examples follow.

For best results, do not use this method to deploy file paths.
**Shadow Cursor setting**  
The Shadow Cursor setting for WordPerfect is stored at the following location for each workstation user:

```
HKEY_CURRENT_USER\Software\Corel\WordPerfect\17\Shadow Cursor
```

To deploy the same Shadow Cursor setting to each user, you must copy the value of the `HKEY_CURRENT_USER` registry key for that setting ("Shadow Cursor State" = *setting*) to the following `HKEY_LOCAL_MACHINE` registry key for the media you copied or extracted to the server:

```
HKEY_LOCAL_MACHINE\SOFTWARE\Corel\Setup\WordPerfect Suite\17\Migrate\Software\Corel\WordPerfect\17\Shadow Cursor
```

**Open File home page**  
The Web Mode view of the Open file dialog box can be customized to use a specified folder as its home page. Users can specify this home page by clicking the Web mode icon in the Open file dialog box, browsing to the desired folder, and clicking Internet > Set home page. This home-page setting is stored as a value ("HomePageURL" = *URL") of the following registry key for each user:

```
HKEY_CURRENT_USER\Software\Corel\PerfectFit\17\Virtual Namespaces\Internet
```

Specify the `HomePageURL` value for the following registry key for the for the media you copied or extracted to the server:

```
HKEY_LOCAL_MACHINE\SOFTWARE\Corel\Setup\WordPerfect Suite\17\Migrate\Software\Corel\PerfectFit\17\Virtual Namespaces\Internet
```

**Migrating installed files to the user profile**  
You can deploy a customized default template, QuickWords list, or QuickCorrect list by creating a registry key at:

```
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Corel\WordPerfect\17\EN\FileMigration
```

In the FileMigration folder, you must create a key for each pair of source folders and destination folders. When you name them, use a name that describes the file's purpose. The following string values must exist within this registry key:

- **SOURCEPATH** — the files' source path
- **DESTINATIONPATH** — the files' destination path. You can use variables such as `APPDATA$` and `PERSONAL$`

When naming, you must follow the following syntax: `FILE_01`, `FILE_02`, `FILE_03`, and so on. It is important the filenames are sequential with no breaks in the
Deploying customized installation settings

To modify the settings used to install the software on the workstations, you can create an XML file and name it Persist.xml.

Each entry you add to Persist.xml must correspond to a public property for the software (see page 11). The syntax of each entry should be as follows:

```xml
<Property name="property" value="value" />
```

By modifying the value of an existing entry in Persist.xml — or by adding a new entry — you can customize the installation settings deployed from the media you copied or extracted to the server. This deployment method offers an excellent alternative to customizing a command line.

**Example 1**

The following Persist.xml entry would specify that automatic software updates are enabled:

```xml
<Property name="ALLOW_PRODUCTUPDATES" value="1" />
```

By changing the value of this entry from "1" to "0" (and saving this change to Persist.xml), you can disable automatic updates for the workstation installations.

**Example 2**

The following Persist.xml entry would specify the serial number for the installation:

```xml
<Property name="SERIALNUMBER" value="SN" />
```

By changing the "SN" value, you can specify a different serial number for the workstation installations.

Deploying the software with msiexec.exe

Alternatively to using Setup.exe, you can deploy the software by using msiexec.exe — a Microsoft Windows Installer file provided by the Windows operating system. In fact, you must use msiexec.exe if you want to interact directly with the MSI files, such as in the following scenarios:

- if you want to use the Setup.msi file, rather than a start-up script, to install the software by using a Group Policy Object
- if you want to use the Setup.msi file to create packages for use with Novell ZENworks Desktop Management

**Command-line syntax**

As with Setup.exe, you use msiexec.exe to create command lines that perform a setup-related function. A msiexec.exe command line requires the following items:
• a switch that signals the desired action: installing (/i), repairing (/f), or removing (/x) the software
• the location and name of the desired MSI file: typically, Setup.msi (located on the installation disc or the media you copied or extracted to the server).
• any desired public properties
• any desired switches, as specified by the CHAINER_CMD="switches" public property (multiple switches are separated by a space)

For example, the following msiexec.exe command line uses the file \server\WPO17\Setup.msi to install the software while displaying the full user interface:

```cmd
msiexec.exe /i "\server\WPO17\Setup.msi"
ADDLOCAL="ALL" CHAINER_CMD="/qf"
```

**MST files**

As previously explained (see page 30), you can use the TRANSFORMS public property to apply an MST file to the setup. By default, all MST files are applied to the Setup.msi file. If you want to apply an MST file to a different MSI file, you must use the following syntax (where MSI is the filename of the MSI file, not including its extension; and where MST is the filename of the MST file, including its extension):

```
TRANSFORMS_MSI="MST"
```

If the MST file is not in the same folder as the MSI file, MST must specify the full path and filename of the MST file.

For example, the following msiexec.exe command line uses the file \server\WPO17\Setup.msi to install the software silently, applies the transformation my_wp.mst to WP.msi (in the same folder), and applies the transformation my_qp.mst to QP.msi (in the same folder):

```cmd
msiexec.exe /i "\server\WPO17\Setup.msi"
ADDLOCAL="ALL" CHAINER_CMD="/qn"
TRANSFORMS_WP="my_wp.mst"
TRANSFORMS_QP="my_qp.mst"
```
Deploying Paradox

You can make Paradox available on the workstations only if it is included in your version of WordPerfect Office. However, please note that the process for deploying Paradox is separate from the process for deploying WordPerfect Office.

You can deploy Paradox regardless of whether you’re deploying WordPerfect Office. However, if you want to deploy both, you must deploy WordPerfect Office first and Paradox second.

For an overview of the deployment process for WordPerfect Office, please see “Stage 1: Preparing for deployment” on page 2.

Copying or extracting the media for Paradox

The process for copying or extracting media for Paradox is similar to the process for WordPerfect Office. Follow the procedures given on page 6, but be sure to use the Paradox setup rather than the one for WordPerfect Office.

Deploying Paradox to the workstations

The process for deploying Paradox to the workstations is similar to the process for deploying WordPerfect Office — just be sure to use the Paradox installation files rather than the ones for WordPerfect Office. Default installation files are provided with the Paradox setup.

If you want to specify individual features in your command line, see “Paradox command-line features” on page 36.

For information on pulling software to the workstations, see “Pulling the software” on page 8.

For information on pushing software to the workstations, see “Pushing the software” on page 9.

Optimizing the installed software

To optimize the installed software, you must refresh the New from project template list in PerfectExpert.

In addition, in order for Paradox to function properly, you must ensure that the network-folder settings for Borland Database Engine points to a folder for which all users have write and delete permissions.
To refresh the PerfectExpert template list
1. Click File \ New from project.
2. In the PerfectExpert dialog box, click Options \ Refresh project.

To change the network-folder settings
1. After installation, log on to the server console as an administrator.
2. From the Windows Control Panel, open the BDE Administrator.
3. Click the Configuration tab.
4. Expand the Configuration tree, and navigate to Drivers\Native\PARADOX.
5. In the right pane, click the field to the right of the NET DIR entry.
6. Click ..., and browse to the location that you have chosen as the network folder.
7. All users must have write and delete permissions on this folder.
8. Click Object \ Apply.
9. Click OK to confirm the save, and then click OK again when you are prompted to restart all Borland Database Engine applications.

Maintaining the software
The process for maintaining the installed Paradox software is similar to the process for maintaining the installed WordPerfect Office software — just be sure to use the Paradox installation files rather than the ones for WordPerfect Office. Default installation files are provided with the Paradox setup.

For information on maintaining software, see “Updating the software” on page 20.

Paradox command-line features
This section outlines the command-line features available for Paradox.

Features are available for the following Paradox components:
• Paradox
• Borland Database Engine
• filters
• templates and sample tables
• writing tools

For a list of available public properties, see page 11.
Remember that feature names are case-sensitive.

The Paradox feature installs the main program file for Paradox and all related files that are essential for running Paradox.
The **Borland Database Engine** feature installs the files that are required to run Borland Database Engine version 5.2.

**Feature filters**

The **Filters** feature lets you install the following parent features:

- **GraphicsConversions** — installs the graphics-conversion filters
- **Spreadsheets** — installs the spreadsheet filters
- **TextConversions** — installs the text-conversion filters
- **WordProcessors** — installs the word-processor filters

### Graphics-conversion filters

The **GraphicsConversions** parent feature contains two sets of graphics-conversion filters: **BitmapGraphicConversions** and **VectorGraphicConversions**.

The **BitmapGraphicConversions** feature contains the following bitmap-conversion filters.

<table>
<thead>
<tr>
<th>Bitmap-conversion filter</th>
<th>Feature name</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMP conversion</td>
<td>BMP</td>
</tr>
<tr>
<td>CAL conversion</td>
<td>CAL</td>
</tr>
<tr>
<td>CPT conversion</td>
<td>CPT</td>
</tr>
<tr>
<td>GIF conversion</td>
<td>GIF</td>
</tr>
<tr>
<td>ICO/COR conversion</td>
<td>ICOCOR</td>
</tr>
<tr>
<td>IMG conversion</td>
<td>IMG</td>
</tr>
<tr>
<td>JPEG conversion</td>
<td>JPEG</td>
</tr>
<tr>
<td>MAC conversion</td>
<td>MAC</td>
</tr>
<tr>
<td>PCD conversion</td>
<td>PCD</td>
</tr>
<tr>
<td>PCT conversion</td>
<td>PCT</td>
</tr>
<tr>
<td>PCX conversion</td>
<td>PCX</td>
</tr>
<tr>
<td>PNG conversion</td>
<td>PNG</td>
</tr>
<tr>
<td>PP4 conversion</td>
<td>PP4</td>
</tr>
<tr>
<td>PSD conversion</td>
<td>PSD</td>
</tr>
<tr>
<td>SCT conversion</td>
<td>SCT</td>
</tr>
<tr>
<td>TGA conversion</td>
<td>TGA</td>
</tr>
<tr>
<td>TIFF conversion</td>
<td>TIFF</td>
</tr>
</tbody>
</table>
The **VectorGraphicConversions** feature contains the following vector-conversion filters.

<table>
<thead>
<tr>
<th>Vector-conversion filter</th>
<th>Feature name</th>
</tr>
</thead>
<tbody>
<tr>
<td>CDR/CMX/CCX conversion</td>
<td>CDRCCX</td>
</tr>
<tr>
<td>CDT conversion</td>
<td>CDT</td>
</tr>
<tr>
<td>CGM conversion</td>
<td>CGM</td>
</tr>
<tr>
<td>DRW conversion</td>
<td>DRW</td>
</tr>
<tr>
<td>DXF conversion</td>
<td>DXF</td>
</tr>
<tr>
<td>EMF conversion</td>
<td>EMF</td>
</tr>
<tr>
<td>EPS conversion</td>
<td>EPS</td>
</tr>
<tr>
<td>HPGLPLT conversion</td>
<td>HPGLPLT</td>
</tr>
<tr>
<td>PIC conversion</td>
<td>PIC</td>
</tr>
<tr>
<td>SVG/XML conversion</td>
<td>SVGXML</td>
</tr>
<tr>
<td>WMF conversion</td>
<td>WMF</td>
</tr>
<tr>
<td>WPG conversion</td>
<td>WPG</td>
</tr>
</tbody>
</table>

**Spreadsheet filters**

The **Spreadsheets** feature contains the following feature: **MicrosoftExcel**, which installs the Microsoft® Excel® spreadsheet filter.

**Text-conversion filters**

The **TextConversions** feature contains the following text-conversion filters.

<table>
<thead>
<tr>
<th>Text-conversion filter</th>
<th>Feature name</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASCII export</td>
<td>ASCIIExport</td>
</tr>
<tr>
<td>Unicode® export</td>
<td>UnicodeExport</td>
</tr>
</tbody>
</table>

**Word-processor filters**

The **WordProcessors** feature contains the following word-processor filters.
The **TemplatesandSamples** feature contains the following templates and samples.

<table>
<thead>
<tr>
<th>Item</th>
<th>Feature name</th>
</tr>
</thead>
<tbody>
<tr>
<td>database template for storing information about valuable coins</td>
<td>CoinCollectionTemplate</td>
</tr>
<tr>
<td>database template for tracking office equipment</td>
<td>OfficeEquipmentTemplate</td>
</tr>
<tr>
<td>sample application demonstrating Web Server Control</td>
<td>HerculesWebSample</td>
</tr>
<tr>
<td>sample database demonstrating graphics in Paradox and ObjectPAL</td>
<td>OceanLifeSamples</td>
</tr>
<tr>
<td>sample tables for Paradox (original versions)</td>
<td>ParadoxClassicSample</td>
</tr>
<tr>
<td>tutorial for ObjectPAL</td>
<td>ObjectPalTutorialFiles</td>
</tr>
</tbody>
</table>

**Writing tools**

The **WritingTools11** feature contains the following feature: **English**, which installs the spelling checker for English.
# Index

<table>
<thead>
<tr>
<th>A</th>
<th>Address Book migration 30</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>command lines</td>
</tr>
<tr>
<td></td>
<td>public properties 11</td>
</tr>
<tr>
<td></td>
<td>running 16</td>
</tr>
<tr>
<td></td>
<td>switches 10</td>
</tr>
<tr>
<td></td>
<td>content 4</td>
</tr>
<tr>
<td>D</td>
<td>deployment</td>
</tr>
<tr>
<td></td>
<td>preparing for 2</td>
</tr>
<tr>
<td></td>
<td>specialized scenarios 25</td>
</tr>
<tr>
<td></td>
<td>desktop shortcuts 12</td>
</tr>
<tr>
<td></td>
<td>DOC files</td>
</tr>
<tr>
<td></td>
<td>associating with WordPerfect 12</td>
</tr>
<tr>
<td></td>
<td>document-management systems</td>
</tr>
<tr>
<td></td>
<td>requirements 3</td>
</tr>
<tr>
<td></td>
<td>setup 4</td>
</tr>
<tr>
<td>E</td>
<td>EULA suppression 12</td>
</tr>
<tr>
<td>F</td>
<td>features, deploying 25</td>
</tr>
<tr>
<td>I</td>
<td>IFilter</td>
</tr>
<tr>
<td></td>
<td>managing installation 13</td>
</tr>
<tr>
<td></td>
<td>installation path 13</td>
</tr>
<tr>
<td></td>
<td>installation settings 33</td>
</tr>
<tr>
<td></td>
<td>installing software 8</td>
</tr>
<tr>
<td></td>
<td>IntelliMirror support 17</td>
</tr>
<tr>
<td>M</td>
<td>macros</td>
</tr>
<tr>
<td></td>
<td>deploying 26</td>
</tr>
<tr>
<td></td>
<td>installing 27</td>
</tr>
<tr>
<td></td>
<td>migrating 27</td>
</tr>
<tr>
<td></td>
<td>maintaining software 18</td>
</tr>
<tr>
<td></td>
<td>migrating</td>
</tr>
<tr>
<td></td>
<td>macros and templates 27</td>
</tr>
<tr>
<td></td>
<td>user settings, automatically 13</td>
</tr>
<tr>
<td></td>
<td>user settings, manually 29</td>
</tr>
<tr>
<td></td>
<td>modifying software 20</td>
</tr>
<tr>
<td></td>
<td>msiexec.exe, deploying with 33</td>
</tr>
<tr>
<td></td>
<td>MST files 30</td>
</tr>
<tr>
<td>N</td>
<td>networks</td>
</tr>
<tr>
<td></td>
<td>requirements 2</td>
</tr>
<tr>
<td></td>
<td>setting up 4</td>
</tr>
<tr>
<td>O</td>
<td>OOOXML support 6</td>
</tr>
<tr>
<td>P</td>
<td>Paradox</td>
</tr>
<tr>
<td></td>
<td>creating server image 35</td>
</tr>
<tr>
<td></td>
<td>list of available features 36</td>
</tr>
<tr>
<td></td>
<td>Paradox deployment 26</td>
</tr>
<tr>
<td></td>
<td>patching software 20</td>
</tr>
<tr>
<td></td>
<td>PPT files</td>
</tr>
<tr>
<td></td>
<td>associating with Presentations 12</td>
</tr>
<tr>
<td></td>
<td>program defaults, deploying 31</td>
</tr>
<tr>
<td></td>
<td>programs, deploying 13</td>
</tr>
<tr>
<td></td>
<td>public properties 11</td>
</tr>
<tr>
<td></td>
<td>pull installations 8</td>
</tr>
<tr>
<td></td>
<td>push installations 9</td>
</tr>
<tr>
<td>Q</td>
<td>QuickCorrect migration 29</td>
</tr>
<tr>
<td></td>
<td>QuickWords migration 29</td>
</tr>
<tr>
<td>R</td>
<td>Readme file 3</td>
</tr>
<tr>
<td></td>
<td>reboots, handling 14</td>
</tr>
<tr>
<td></td>
<td>registry keys 31</td>
</tr>
<tr>
<td></td>
<td>removing software 22</td>
</tr>
<tr>
<td></td>
<td>repairing software 18</td>
</tr>
<tr>
<td>S</td>
<td>SCCM support 17</td>
</tr>
<tr>
<td></td>
<td>serial number, inputting 14</td>
</tr>
<tr>
<td></td>
<td>servers</td>
</tr>
<tr>
<td></td>
<td>setup 4</td>
</tr>
<tr>
<td></td>
<td>software requirements 2</td>
</tr>
<tr>
<td></td>
<td>setup</td>
</tr>
<tr>
<td></td>
<td>logging events 10</td>
</tr>
<tr>
<td></td>
<td>suppressing UI 11</td>
</tr>
<tr>
<td></td>
<td>SharePoint setup 4</td>
</tr>
<tr>
<td></td>
<td>shortcuts, desktop 12</td>
</tr>
<tr>
<td></td>
<td>silent installations 11</td>
</tr>
<tr>
<td></td>
<td>SMS support 17</td>
</tr>
<tr>
<td></td>
<td>software requirements 2</td>
</tr>
<tr>
<td></td>
<td>suppressing setup check 12</td>
</tr>
<tr>
<td></td>
<td>switches 10</td>
</tr>
<tr>
<td>T</td>
<td>table rows, splitting 14</td>
</tr>
<tr>
<td></td>
<td>templates</td>
</tr>
<tr>
<td></td>
<td>deploying 26</td>
</tr>
<tr>
<td></td>
<td>installing 27</td>
</tr>
<tr>
<td></td>
<td>migrating 28</td>
</tr>
<tr>
<td></td>
<td>troubleshooting software 24</td>
</tr>
<tr>
<td>U</td>
<td>uninstalling software 22</td>
</tr>
<tr>
<td></td>
<td>updating software 20</td>
</tr>
<tr>
<td></td>
<td>upgrading software 14</td>
</tr>
<tr>
<td>V</td>
<td>videos 4</td>
</tr>
<tr>
<td>W</td>
<td>workstations</td>
</tr>
<tr>
<td></td>
<td>setup 4</td>
</tr>
<tr>
<td></td>
<td>software requirements 3</td>
</tr>
<tr>
<td></td>
<td>WPD files, locking IE display 16</td>
</tr>
<tr>
<td>X</td>
<td>XLS files</td>
</tr>
<tr>
<td></td>
<td>associating with Quattro Pro 12</td>
</tr>
</tbody>
</table>